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1 INTRODUCTION
1.1 PURPOSE

The QPVD User’s Guide describes how the Target Generator Facility (TGF) QPVD is
used.

1.2 ORGANIZATION

The Target Generation Facility (TGF) at the Federal Aviation Administration William J.
Hughes Technical Center (FAA Technical Center) is managed by the System Simulation
Support Branch, ACB-860, of the Aviation Simulation and Human Factors Division,
ACB-800.

Simulation Group (ACB-860)
Real & Virtual Division (ACB-800)



2 OVERVIEW
2.1 QPVD System Overview

QPVD provides a graphical interface showing the targets that the TGF create.
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Figure 1 QPVD fully populated



3 The QPVD GUI
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Figure 2 initial QPVD GUI



3.1 QPVD Menubar

The QPVD GUI contains a custom menubar. Depending on how QPVD was started
determines which menu items are displayed.

Figure 3 QPVD Menubar

NOTE: Several menu items will not be displayed when using
QPVD within the SimPilot workstation, (such as File and Tools)
You may ignore sections 3.1.1 File and 3.1.3 Tools.




3.1.1 File (Not available on SimPilot Workstations)

The submenus of the File menu are:

Eead

New View

Save

Close

Exit

Figure 4 File Menu

3.1.1.1 Read

This opens a dialog where you can select an XML file to be read in. Appropriate files
(for the time being) are airspace definitions, the specific map details and all static data.
Inside the file selection dialog, you can use the icons and directories to navigate to the
desired file, or you can input the path in the textbox at the top. This will take you to the
desired directory where you must still select the desired file. Normally this file is read in
automatically when the QPVD screen is brought up together with a specified argument.

Look in: I_Urg_ffqpvdf

55

Ibackup

Jentl

File name: || Open
File type: | *.xml -] Cancel |

L 4

Figure 5 Open XML file




3.1.1.2 New View

This spawns a new window of qpvd. The new window functions separately from the
original window, to a degree. Anything “static” will affect both windows. For example,
displaying certain fixes in one window will not affect the other. Changing the default
color for fixes in one window will, however, affect the other window.



3.1.1.3 Save

Fix XML: If’rgffdata.-"drvsnl?;_zdchix.xnl] Browse

Airway XML.: If’rgffdam.-"drvsm3_zdch0LLre.xm] Browse

STAR Route XML: Ir’rgffd ata/drvsm3_zdc/StarRoute.xml Browse

SID Route XML: I Browse

Node XML: If’rgﬂ’darafdrvs;1113_zdcﬂ'~]ode.xm] Browse

FPA XML: Ir’rgﬂ"damfdrvsm}_zdchpa.xm] Browse

Geomaps XML: I Browse

Radar XML: | Browse

Radar Sort Box XML: I Browse

FEEEEEEEEE

File to save preferences to: I)’rgffqpvd;"fcnt];"drvsnl?;.xnl]l Browse

OK Cancel |
[ |

Figure 6 Save preferences

3.1.1.4 Close

This will close the current window. If there is only one window open for qpvd, this will
cause the program to terminate.

3.1.1.5 Exit

This causes the program to terminate and exit, regardless of how many windows are
open.



3.1.2 Edit
i i

File |[Edit Tools Fixes Airw:
Undo Cul+Z

Figure 7 Edit

The submenus of the Edit menu are Undo and Redo.
Undo: This will undo the last change made or the last command entered.

Redo: This will redo the last undone command or change.



3.1.3 Tools (Not available on SimPilot Workstations)

Change DIS settings

Start DIS
Stop DIS

Figure 8 Tools
3.1.3.1 Change DIS settings

This will create a dialog which allows the user to change which port to listen for DIS
broadcasts on. Currently the host IP is hard-coded and entering anything in this field will
not affect anything.

Host [T

Port (3209

Ok Cancel |

L _J

Figure 9 Change DIS settings

3.1.3.2 Start DIS

This will cause gpvd to begin listening for DIS broadcasts on the specified port. (The
default port is 3240.)

3.1.3.3 Stop DIS

This will cause gpvd to cease listening for DIS broadcasts.



3.1.4 Fixes

File Edit Tools m Airways Tracks Maps Weather

IT Display fix layer ]
Configure fixes

IT Display fix names

Colors

Symbols

Figure 10 Fixes

The FIXES submenu contains all the fixes in the current exercise. Each fix when chosen
will be able to be placed on the map according to its latitude and longitude coordinates.

The fix customization dialog allows the user to extensively alter what fixes are displayed,
as well as the manner in which they are displayed. On the left-hand side of the dialog is a
list box which contains all the fixes in the current airspace definition, as well as the
option, “Default”. Any changes made to “Default” will affect fixes drawn in the default
style—that is, a fix which has had no specific style dictated. Any change made to a
specific fix will affect that fix only, but will label it as non-default.

For example, the default style is changed to draw in the color green (instead of cyan). A
specific fix is changed to have a circle drawn on its position (and no other changes are
made). Because that specific fix has been altered, it no longer utilizes the default style
for fixes, and will still be drawn in the color cyan. To have a non-default fix use the
default style, it must be “removed” from the display, then re-displayed. This is possible
through the command and the configuration dialog. To do this through the configuration
dialog, you must select the fix, de-select the “Display this fix”” check-box, and then click
the “OK” button. Next, go back in to the configuration dialog, find the fix, and select the
“Display this fix”” check-box and click “OK” again.

Any changes made through the configuration dialog occur once the “OK” button is

clicked. In addition, they occur at the same time, so selecting “undo” from the “Edit”
menu will undo all changes of just executed.

10



3.1.4.1 Display fix layer

This will toggle the display of the fix layer. This will not destroy any data on what fixes
are displayed, or in what manner they are displayed—it will simply tell qpvd to not draw
fixes to the screen. This is a toggle option, so selecting it will turn it on or off.

3.1.4.2 Configure fixes

This will open a dialog, allowing the user to extensively customize the manner in which
fixes are displayed.

b d Configure Fixes

ILM295029 Display this fix r Display name "
ILM295035
ILM315045
ILM335032
ILM354023
ILM359012
ILN -
IMELL
IMELY

ING

INGON

THRILIT T Rt
{I | »

Help | Apply OK Cancel |
. =

Color I cyan j Custom

Symbol I No symbol j

Figure 11 Configure Fixes

There is a list of predefined colors, as well as the ability to select a custom color by either
clicking the appropriate “Custom’ button, or selecting “custom” from the drop-down list.

11



3.1.4.2.1 Custom Color

Anytime the custom (color) button is selected, the following GUI appears:

&4 Select color

Basic colors

IR
TR
llllll_l_l_‘:

Custom colors

Hue: Iﬁﬂ Red:

A T T T
Fr L i R
| Val: IE Blue: I{}_
OK Cancel | Add to Custom Colors |

- -

Figure 12 Select custom color

Here you may choose any basic color or create your own custom color.

3.1.4.3 Display fix names

This will toggle the display of the fix names, selecting it will turn them on or off.

12



3.1.4.4 Colors

This will open another list, containing a list of colors. Selecting a color will affect the
default color for fixes to be drawn in.

IT Display fix laver
Configure fixes
IT Display fix names
Caolors Red

Symbols Yellow

Blue

Cyan
White
Green

Custom

Figure 13 Fix colors

Selecting “custom” from the drop-down list will also display the Custom Color GUI. See
Section 3.1.4.2.1 Custom Color.

13



3.1.4.5 Symbols

This will open a list, containing a list of symbols. Selecting a symbol type will affect
whether by default, a symbol should be drawn on the location of a fix.

File Edit Tools | Fixes Airwayvs Tracks Maps Weather
IT Display fix laver

Configure fixes
IT Display fix names

Colors

Symbols
2 Circle, empty
3 Circle, filled
4 Circle, empty with dot
3 Square, empty
6 Square, filled
7 Square, empty with dot
8 Triangle. empty
9 Triangle, filled
A Triangle, empty with dot
B Inverted triangle, empty
C Inverted triangle, filled
D Inverted triangle, empty with dot

£ No symbol

Figure 14 Symbols
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3.1.5 Airways

Airways

STARs »
SIDs r

Figure 15 Airways

The AIRWAYS menu will contain all the airways in the particular simulation exercise
currently running. If there are none it will be indicated by an appropriate dialog pop-up.
Any airway of interest can be chosen from the AIRWAYS submenu.

There are configuration dialogs for airways (for example, “jet” and “victor” airways),
STARs, and SIDS. Though they all affect a different type of airway, the dialogs utilize
an identical interface. On the left-hand side of the dialog is a list of the airways in the
current airspace definition, in addition to the “Default” option. Changes made to the
“Default” option affect airways drawn in the default style. See the section above
(“Fixes”) for more information on what types of objects are excluded from this.

The “Display this airway” option toggles whether a specific airway should be drawn.

The user may also specify a color for the airway to be drawn in, choosing from a list of
predefined colors or specifying a custom color using the color selection dialog. (Try
clicking “Custom”--the dialog is intuitive.) The user may also select a symbol to be
drawn at each fix along the airway, and a line-style to draw the airway using. Finally, the
user may specify if (and how) names should be drawn along the airway.

Changes are made once the “OK” button is clicked and occur in unison. If the “undo” (or
“redo”) functions are used, they will undo and redo all the changes the user just made.

15



3.1.5.1 Airways

This menu option encompasses three other options: “Airways”, “STARs”, and “SIDs”.
Each of these options gives the user the ability to change how airways, STARs, and SIDs
are displayed. The sub menus for each of them is the same —See Section 3.2.5.4 Sub
Menus for Airways.

File Edit Tools Fixes Ajmau Tmck% Maps Weather

STARa g Qunﬁgure

SIDs ’ Colors k
Names
Symbols

Lines

Figure 16 Airways

3.1.5.2 STARs

Configure
Colors

Names

Symbols

Lines

Figure 17 STARS
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3.1.5.3 SIDs

Airways »

STARs »

|T Display layer

Configure

Colors
Names
Symbols

Lines

Figure 18 SIDS
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3.1.5.4 Submenus for airways

Each sub menu of airways has the same options:

|T Display layer

Configure

Colors J
Names *
Symbols *
Lines >

Figure 19 Airways options

3.1.5.4.1 Display layer
This toggles whether the layer containing these objects should be drawn.

3.1.5.4.2 Configure

This opens a dialog, allowing the user to customize which airways are displayed and in
what manner.

bd Configure Routes

1SO041 =

1SO302 Display this object r

ISO318

T Color I vellow j Custom
J110 = |
J121

J134 Symbol I No symbaol j

L |

i ke | Solid line

[kl

Name style I Route name

Apply | OK | Cancel |=|]

Figure 20 Configure Routes
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3.1.5.4.3 Colors

This allows the user to change the default color airways are drawn in, without having to
use the configuration dialog, or choose custom to select custom colors.

v Display layer

Configure

Names ’ Yellow

Symbaols 4 Blue

Cyan

White

Green

Custom

Figure 21 Color choices

3.1.5.4.4 Names

This allows the user to change how (and if) names are drawn along the airway by default.

-

[

isplay laver

1 No names

Symbols ¥ 2 Route name

Lines

3 Fix name

4 Route and fix name
i~ { HCH
Figure 22 Names
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3.1.5.4.5 Symbols

This allows the user to change whether a symbol is drawn at each fix along a given
airway by default.

+ Dhsplay laver
Configure
Colors *

MNames

Symbols 1 Dot

2 Circle, empty

3 Circle, filled

4 Circle, empty with dot

3 Square, empty

6 Square, filled

7 Square, empty with dot
8 Triangle, empty

9 Triangle. filled

A Triangle. empty with dot
B Inverted triangle, empty
C Inverted triangle, filled
D Inverted triangle., empty with dot

Z MNo symbol

Figure 23 Symbols

3.1.5.4.6 Lines
This allows the user to change the type of line used to draw an airway by default.

’T Display layer

Configure
Colors »
Names 3

Svymbols

1 Solid line
2 Dashed line
3 Dotted line
4 Dash-dot line
5 Dash-dot-dot line

Figure 24 Lines
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3.1.6 Tracks

File Edit Tools Fixes Airways | Tracks Maps Weather

Display laye

Turn all datablocks on Confizure

Turn all datablocks off Colors

MNames

Symbols

Lines

Figure 25 Tracks

3.1.6.1 Aircraft routes
The same dropdown menu choices are used as airways. See section 3.1.5.4. Submenus
for airways

Turn all datablocks on — toggles flight datablocks to be displayed.

Turn all datablocks off — toggles flight datablocks not to be displayed.

HPW
~.CHQ2126
270 453
T/E145/W|LGA

— ] ‘

N872RF,~

T/H25B/W BKW

Figure 26 Flight displayed with datablocks on
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3.1.7 Maps

.V apvd

File Edit Tools Fixes Airways Tracks | Maps Weather

Configure geomaps

Configure sectors

Figure 27 Maps

3.1.7.1 Configure geomaps

This opens a dialog allowing the user to customize the geomap being displayed. The
geomaps information must be loaded before this can become useful. Only one geomap
can be displayed at a time

The geomaps configuration dialog allows the user to change the map being displayed, as
well as what lines or symbols are displayed (and in what color they are drawn). The list
box on the left-hand side of the dialog contains a list of geomaps that qpvd knows about,
in addition to the option, “None”.

4/2 Sector | Custom E Custom
4/3 Warning (1 | Custom Z Custom
4/4 Airway 1 ) | Custom |- Custom
4/5 Airway 2 r Custom = Custom
5/0 Symbol ] | Red | Custom
5/1 Airport I |Red | Custom
Apply Cancel OK

Figure 28 Configure geomaps
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Each line and symbol type is followed by a check-box. Selecting or de-selecting this
check-box will affect whether those lines or symbols are drawn. In addition, the user can
use the drop-down list to select a color for a specific line or symbol group. There is a list
of predefined colors, as well as the ability to select a custom color by either clicking the
appropriate “Custom” button, or selecting “custom” from the drop-down list.

Changes are made in unison once the “OK” button is clicked—using the undo or redo
options will affect all the changes that were just made.

3.1.7.2 Configure sectors

Display name ~
03 Color Yellow j Custom |
04
05 Alntude: All JI
06
EZ =l Apply OK | Cancel |

L )

Figure 29 Configure sectors

This allows the user to change which flight plan areas (FPAs) are displayed. The FPAs
are separated by sector number, so selecting a sector to be displayed will draw all FPAs
for that sector.

When the Altitude slider is all the way to the left, all FPA’s will be displayed, otherwise
an FPA is displayed if it includes the specified altitude.
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3.1.8 Weather

Configure precipitation

Intensity 1 [
Intensity 2 2
Intensity 3 2
Intensity 4 v
Intensity 5 W
Intensity 6 W
Apply Cancel Okay |

L -

Figure 31 Configure precipitation
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4 Mouse Buttons

Left button — select current aircraft
Center button — toggle display of single aircraft data block
Right button — alter datablock offset

Shift and left button — zoom in
Shift and center button — re-centers map

Shift and right button — zoom out

Control and left button — highlight aircraft
Control and right button — display route of aircraft
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